
Sun City Computer Club
Cyber Security SIG
December 5, 2024

Questions, Comments, Suggestions welcomed at 
any time

Even Now



Audio Recording In Progress

SIG attendees are required to be members of the 
chartered club sponsoring that SIG.
Sun City Community Association By-law

 Audio recording of this session as MP4 file
 Audio recording available at link shown above

 Wake Words

 (re)Mute your selves

https://vimeo.com/1036532442


New Leader???

 SIG Leader replacement

Take over
 Inclusion Zoom & Recording
 Training, Counsel
 Summers are Important

Leader(s)???
Contributors
 Wayne Kurtz, David Barnes, Tom McBride,

Bob Allen



 NRO Anti-Fraud Group presentations

Activities Center Atrium

3:15 – 4:15

December 9, December 16

January 13, January 20, January 27

February 3, February 10, February 17

 Scams and Computer Safety SIG

 Sun Rays Anti-Fraud Group



Browser Versions

 Chrome Version 131.0.6778.109 (Official Build) (64-bit)

 Edge Version 131.0.2903.70 (Official build) (64-bit)

 Firefox Version 133.0

 Safari version 18.1.1  (20619.2.8.11.12)

 Brave Version 1.73.97 Chromium: 131.0.6778.108

 Vivaldi Version 7.0.3495.23

 DuckDuckGo  Version 0.94.3

 Arc Version 131.0.6778.86

 Tor 14.0.3

 ChromeOS 131.0.6778.96



Rejected Newsletter Article
Can you spot the mistakes?



Current Issues

 Wi-Fi nearest neighbor attack – across the planet

Drone on the roof

 Finastra financial services giant data breach

8,100 financial institutions   400GB

 JPMorgan Chase pays $40 billion in fines

Anti-competitive practices, securities abuses, and others

 Thousands of Palo Alto Networks firewalls hijacked

Use of recently patched security vulnerabilities

Installed backdoors, crypto mining and other malware

 T-Mobile unsupported phone brands 

4G Band 71   5G N71

T-Mobile customers informed

Mint Mobile, US Mobile, Tello, and others not informed

 New York Times Chinese Telecommunications Hack

 FBI CISA Joint Communications Infrastructure Guidance

https://www.nytimes.com/2024/11/22/us/politics/chinese-hack-telecom-white-house.html
https://www.cisa.gov/resources-tools/resources/enhanced-visibility-and-hardening-guidance-communications-infrastructure


Current Issues

 Synapse fintech middleman crisis
NOT FICA backed regulations
Yotta, Juno, and others

 Eken video doorbells
Aiwit, Andoe, Bitepass, CutePanda, Eken, Fishbot, Gemee, Guggre, Luckwolf, Rakeblue and 

Tuck

 Sad Announcement email  - with full name of acquaintance
“When you open them you will see why I actually wanted to 

share them with you today”
“Never thought I would want to share these images with you, 
anyways here they are”
 Air Fryer(s)   Location, recorded audio permissions
 Water systems “high risk vulnerabilities”

And UK-based Thames water “falling apart”
DEF CON Franklin project

 Undersea cable advisory board
15-2000 cable faults per year   3 repairs per week



Current Issues

 US based data brokers – data Wiesbaden Germany

 Graykey & smartphones  iOS 18.1

Before First unlock

Data encrypted   PIN REQUIRED  Wi-Fi passwords encrypted

SIM available if not PIN protected  No contacts listed

No iMessage previews

After First unlock most data available (unencrypted)

Law Enforcement & attackers – powered on but isolated

iCloud access

iOS 18 reboot after 72 hours of inactivity

Springboard  then kernel panic

iOS 18 tells other iPhones on lower iOS versions – Reboot

Wirelessly  ??

 CISO professional liability insurance



Current Issues

 CISA access via web shell from previous CISA engagement

 Proton roadmap

Proton Mail

increased security improved SPAM & phishing detection

Language support for Finnish & Hindi

Desktop Proton Mail as mail default app

Proton Calendar

More integrated with Proton Mail

Advanced event scheduling

personalized notes for calendar invitations

Proton Drive

macOS app, public docs & folders, enhanced organizational 
tools



Current Issues

 QNAP firmware update locks NAS access from customers

 Blue Yonder suffering ransomware attack

Supply chain management for thousands of companies

Starbucks, Morrisons

5 or so per 2011

20-25 major ones per day

 Matrix threat actor

Botnet    cameras, video recorders, routers

Multiple vulnerabilities & tools from Internet hacking forums

35 million world-wide     admin:admin     root:camera

di-it-all-yourself cyberattack

 Department of Homeland Security programs

SMARTLink   Intensive Supervision Appearance Program

 0-click 0-day vulnerabilities

Firefox, Tor, October 9  Windows  November 12



Intel

 Inruder - attack surface management 

 Intel 

 Tracks trending CVEs

https://intel.intruder.io/?utm_source=thehackernews&utm_medium=p_referral&utm_campaign=global|fixed|intel




Paze



Paze



Paze



Paze



Paze



Paze



Paze



Paze



Paze



Paze   YOUR DIGITAL WALLET



Paze  YOUR CARD DETAILS



Paze

 Opt Out

 https://mywallet.paze.com/footerOptOut

 Token based

 WEB based

https://mywallet.paze.com/footerOptOut


Paze



Paze Service Agreement



CurrentC

 Walmart & other merchants

 No transaction fees

 Customer data collection

 Now Walmart Pay

 Poor security

 Additional App



Current Issues

 Cyberwarcon – annual conference report

North Korea gaining cybercurrency

VC, recruiters, IT workers

teleconference issues “load this to fix”

Remote IT workers: pay, steal secrets, plant spyware, 
extortion, …

 UEFI bootkit for Linux

Bootkitty

 AI phishing

smishing

vishing

Thanks for the contribution



Current Issues

 "Surveillance and Digital Control at Work“

 Google Play Store app purge



Current Issues

 Salt Typhoon  thousands of thousands network gear needs  
replacing

 7-Zip malware vulnerability – patch

 Hoboken, New Jersey city hall ransomware

All services suspended

 Reminder Bing Wallpaper App

Peruse Chrome cookies “to ensure Bing app is already installed

 FBI warning

scam websites up 89%

80% of shopping offers in inboxes are fraudulent

Search engine results poisoned to send traffic to bad sites

FBI Shopping Warning

https://www.fbi.gov/contact-us/field-offices/sanfrancisco/news/fbi-warns-the-public-of-holiday-scam-trends?form=MG0AV3


Current Issues

 Check Point online shopping warning
 Check URLs closely for misspellings or unusual 

host domains.
 Make sure the URL starts with “https:// and 

shows a padlock icon.
 When emails come in, reference the sender 

against emails you know to be real. Don’t click 
anything you’re not sure about.

 Don’t blindly click through on QR codes.
 Never input unnecessary details like your social 

security number, and avoid inputting extra info 
like your birthday where it’s not required.”



Current Issues

 Examples:
• Stüssy (Steatwear): stussycanadablackfriday[.]com

• Longchamp (Bags): longchampblackfriday[.]com

• Wayfair (Online Home Store): 
wayfareblackfriday[.]com

• SOREL (Footwear): soreloutletblackfriday[.]com

• Crew (Retail): jcrewblackfriday[.]com

• IUN (Footwear): blackfriday-shoe[.]top



Current Issues

 Mobile devices with smaller screens
 If in doubt:
• “Report the scam immediately to authorities like 

Action Fraud in the UK or the FTC in the US
• Tell your bank and, if relevant, freeze your cards –

requesting new ones
• Stop contact with the scammer and don’t tell them 

why
• Change any passwords that may have been 

compromised
• Freeze your credit to prevent scammers opening new 

credit lines in your name. You'll need to contact each 
of the three major credit bureaus separately: 
Experian, TransUnion, and Equifax

• Gather evidence of the scam in case it is required”



Google Maps reporting from Waze



Spy Loan

 FALSE financial tools

 Loans “fast-tracked”  deceptive / false terms

 15 Apps in Google Play store

 8 million downloads

 Misuse of permissions



Spy Loan examples



Current Issues

 Member contributed article, Thanks David

Wired article Google Photos & AI

 US Coast Guard warning Chinese port cranes

 Pakistan blocks BlueSky

 REPO swatting attacks

GitHub & GitLab   attacker sneaks malicious files to repo

reports to GitHub or GitLab

Account taken down

 Palo Alto Networks vulnerabilities attacked

Very good reputation – not deserved   PHP 

 D-Link VPN routers with un patchable EXTREME vulnerabilities

DSR-150  150N  250   250N

DSR-500N 1000N

 VPN usage against Shariah law   abetting in sin

https://www.wired.com/story/website-google-ai-photos-ente/


Current Issues

 Chinese lidar sensors  complex firmware

Potential disable via satellite lasers

 ChatGPT freeze for names: David Mayer et al

 Potential Microsoft license hack

Extended Security Update?   Windows 10

 Samsung delay Android 15 – Fake Updates

 https://theyseeyourphotos.com/

This web site takes a photo you download to this site, then has Google 

use its AI to document what Google's AI sees and documents any findings.

This information was posted on the Computer Club’s AI SIG 
Message Board.
Consider posting your AI findings to inform other club 
members!

 AT&T to shutdown DSL and traditional phone service

https://theyseeyourphotos.com/


Current Issues

 UK cyber report 2024 triple number of threats over 2023

 Amazon super computer with home-grown AI chip

Apple also uses Amazon AI chips

 National Public Data shuts down 

272 million SSN  600 million phone numbers

 Digital epileptic seizures  

image-based automatic driving systems  - epilepticar

 Tor seeking WebTunnel bridge volunteers

Tor project WebTunnel paper
 Zello (mobile push-to-talk app) request all users change passwords

 Android scareware – mimic cracked or malfunctioning screens

 Corrupt file sent by attackers

Bypass security suites and email filters

Click here to recover corrupt file => Infection

https://blog.torproject.org/introducing-webtunnel-evading-censorship-by-hiding-in-plain-sight/


World Labs 3D generation



Windows Recall 

 Microsoft Windows Recall feature available

Insider build 26120.2415  Snapdragon Copilot+ PCs

Microsoft Windows Insider blog

Ability to disable/turn off ?

Requires Windows Hello face or fingerprint enrollment

Click to Do to be expanded

Search both text and image

Search filter: financial, encrypted messaging, …

Not available on IT managed machines

Requirements:

BitLocker or device encryption

TPM 2.0

Windows Hello

Hyper-V

https://blogs.windows.com/windows-insider/2024/11/22/previewing-recall-with-click-to-do-on-copilot-pcs-with-windows-insiders-in-the-dev-channel/


Current Issues

 iOS and Android spyware checker

iVerify  Basics $1   Subscribers get regular scans

App creates file to download to iVerify for analysis

Provide email address

 Microsoft Windows 11



Current Issues

 New discovery   Universal memory

Indium-Selenide (In2Se3)   Phase-change memory

Store data without power



Windows Recall Search settings



Microsoft Connected Experience

 Microsoft Connected Experience
Microsoft Office Word and Excel document content  AI 

“Connected experiences that analyze your content are 
experiences that use your Office content to provide you with 
design recommendations, editing suggestions, data insights, 
and similar features.”

ON BY DEFAULT

File -> Options -> Trust Center -> Trust Center Settings 

-> Privacy Options -> Privacy Settings -> Connected experiences





Microsoft Connected Experience

 ON BY DEFAULT



Microsoft Account

 Office App

File -> Account -> Account Privacy -> Manage Settings

Connected Experience OFF



And everywhere?



Microsoft

 AI any/everywhere
The Connected Experiences setting enables cloud-
backed features designed to increase your 
productivity in the Microsoft 365 apps like 
suggesting relevant information and
images from the web, real-time co-authoring and 
cloud storage, and tools like Editor in Word that 
provide spelling and grammar suggestions. 
Microsoft has been using AI in Microsoft 365 for 
years to enhance productivity and creativity 
through features like Designer in PowerPoint, 
which helps create visually compelling slides, and 
Editor in Word, which provides grammar and 
writing suggestions. These features do not rely on 
generative AI or Large Language Models but
rather use simpler machine learning algorithms.”



Current Issues

 Microsoft Vision

Understand & respond to Microsoft Edge screens



SCCCCyber@gmail.com

 Recovery Seminar
 https://vimeo.com/882272974?share=copy
 NOW, Your input, experiences, …

 Helpful < - > Harmful
 Awareness, Preparedness, Understanding

Computer Club, Help Center, SIGs, Presentations, classes
Cyber Security SIG meetings, NEWSBLOG
Internet

 Questions, suggestions, comments?

https://vimeo.com/882272974?share=copy
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